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Powerto the people
lthough a major part of the MS
Office contingent, PowerPoint
has the dubious distinction of
being the least-installed part

of the suite. For many people it’s just “the
other thing that comes with Office”. And
despite the fact that they’re sure it’s terribly
clever, try as they might they can’t think of
a single good use for it. In fact, many would
even prefer it stayed safely on the Office
CD-ROM rather than cluttering up their
beloved hard drive.

All of which is something of a shame,
because PowerPoint 2001 is a surprisingly
entertaining application, and increasing
numbers of people from all areas of
endeavour are finding uses for it in all
manner of situations. Your first thoughts
might be of lectures, training sessions and
sales presentations that can be viewed on
your Mac or blown up to gargantuan
proportions and projected onto huge
screens at the front of a lecture theatre or
conference hall. But there’s more to

PowerPoint 2001 than this. Thanks to the
new Make Movie feature you can make
QuickTime movies that you can then email
either as dynamic newsletters, or to show
off your holiday snaps to friends and loved
ones. And with the Save As Web Page
option common to all Office 2001
components you can even use PowerPoint
to design interactive websites.

So, why not use up some of that free
hard-disk space after all, install PowerPoint
and see what you can do with it?

A

words Tim Norris
A waste of space or a feature-packed and entertaining application? Find out what Microsoft’s updated
presentation package really offers and how you can get the best out of it. 

WIN!
THREE COPIES OF MS OFFICE

2001 UP FOR GRABS! SEE

PAGE 66.
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When you launch PowerPoint 2001 you’re greeted 
by the familiar Office Project Gallery. The old
AutoContent Wizard has been replaced by a set of

pre-designed presentations, so that you’re now forced to
consider the new presentation as a whole rather than just
work through a series of questions which result in a finished
product. For an even more DIY approach, just select a blank
PowerPoint presentation.

1 A PowerPoint presentation takes the form of a series
of slides and there’s a healthy selection of slide
templates to choose from. Once you’ve chosen

which model to use, each one can be customised and you can
also easily design your own templates and masters – perhaps
having your company logo in the background. With pretty
much every eventuality covered, we’ve decided to go for a
fairly simple “text and clip-art” slide.

2 As soon as the blank slide has appeared on the new
three-paned working window, you can double click
on the clip-art section of the slide to gain access to

the gallery common to all Office 2001 components. The clip
art, of which there’s a massive amount on the CD-ROM, is
easy to browse and with such a variety of content you’ll easily
find something you like.

3

Tutorial 1: New look, new tools, new help
PowerPoint presentations often have a sameness about them and the reason, as we mentioned in our tutorial in issue

98, is that it’s all too easy just to let the AutoContent Wizard do all the design work for you. PowerPoint 2001 has just as

much automation built in, but now it’s easier to go your own way.

The Bullets and Numbers section of the Formatting
palette now gives you the option to use a picture as
a bullet for lists. Again there’s a decent selection in

the clip-art gallery, but there’s no reason why you can’t use
any suitably-sized image to mark your important points.

4 As a navigation aid, the text also appears in the
pane to the left of the window. Like any other
document outline, this can be collapsed to show just

the headings if you wish. Viewing options are provided by the
buttons at the bottom of the window including normal view,
outline view (large left-hand pane), slide view (big slide, small
navigation pane), slide sorter view (storyboard) and slideshow
(presentation preview).

5 To make a presentation slightly more exciting than if
it were just a few handwritten overhead projector
slides, you can animate just about everything and

there are two ways of doing it. From the Slide Show menu
you can select Animations and pick what takes your fancy. All
the entries in the currently selected box (including graphics)
will be animated in the style you select. Bullet points will be
animated one by one.

6

If you want to get really flash, you can fine-tune the
animation using the Customize button on the
Animation section of the Formatting palette. From

here you can change the order of the animation, the timings
and the precise details of the animation itself, including its
direction. The default usually has the picture coming in last on
a slide with a graphics window, which often isn’t ideal.

7 Making it easier to organise your thoughts there’s
this handy storyboard-style view called the “slide
sorter view”. Instead of the text you see in the

outline pane, this view lets you see thumbnails of the slides
themselves, which can be very helpful when it comes to
sorting out the most sensible order for your slides.

8 Although there are many new tricks to show you
yet, this is all you need to bash out a standard
presentation. Once the work’s done you can decide

how you want your project to look. Use Set Up Show from the
Slide Show menu to select exactly how you want the
presentation to be controlled. If, for example, you want it
to run on its own, simply select Rehearse Timings.

9
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Less is more – no, really
lthough there are lots of flashy
new presentation gimmicks,
animations, transitions and so
on, the old advice is still more

than relevant – don’t overdo it. There’s a
huge temptation to throw in every single
trick you can find, but like a newsletter, the
more you clutter a presentation with
fiddle-faddle and folderol, the harder it gets
to work out what it is you’re trying to say.
Animated text, for instance, can have a
sound effect attached to it – a skidding car,
a gunshot, etc – and it seems entertaining
the first time you hear it. But imagine how
irritated you’d be by the end of a long
presentation, if every bullet point were
greeted by cuckoos or cheering crowds.

Integrated
Another feature to point out is the fact that
a great many of the tools found in the
other Office 2001 applications can also be
found in PowerPoint 2001. The table
drawing tool, for example, is there along
with the other drawing tools and Word Art
for fancy text effects. And you can access
Microsoft Graph, which is hidden away in
your Office folder, to add charts to slides.

The master
When you feel confident about moving
away from the preset designs and you
want some more flexibility with your own
designs, or when the marketing
department finally decides on a house 

style for presentation slides, you can set
up slide masters of your own, which define
the basic layout for all the slides in a
presentation. Everything from the
background image to the typestyle of every
level of bullet point and the style and
position of footers and slide numbers is
covered. As such, the process is streamlined
and gives your presentations a unique, yet
coherent and organised look.

It’s all in the timing
Once all of your slides are written and
designed, it’s time to take a look at exactly
how you’re going to present your work. It
is possible to have the presentation play
itself, so you may need to set the timings

A

Once again there’s a handy template set up to help
you. This time, you’re given options for a slide with a
text box and a media clip box. You can add any sort

of QuickTime file – video or audio – to a presentation.

1 Double clicking on the media clip box will bring up a
standard file dialogue, so you can simply find the
QuickTime clip you want and have it automatically

re-sized and placed on your slide.

2 You’re not limited to QT movies, either. You can use
animated GIFs, too. If you’re going to be using the
clips a lot, it helps to place them or their aliases in

the ClipArt Gallery. Importing files into the gallery is simple
and means that you can easily find those often-used clips.

3

Tutorial 3: Saturday night at the movies
Sometimes there’s little difference between a boring PowerPoint presentation and one using an overhead projector and

some coloured pens. But here’s something you can’t do on an OHP slide – add video clips.

Select Slide Transition from the Slide Show menu to
bring up this dialogue box. The pop-up list
immediately below the thumbnail contains a list of

PowerPoint transitions and also gives you the opportunity to
use QT transitions.

1 The transitions here are much more video-like and
can be controlled with a bit of precision to give some
rather intriguing effects. However, although they can

spice things up quite a bit, the general advice, as always, is
not to go overboard.

2 As is so frequently the case, you can use the
Formatting palette for even simpler access to the
controls – all you need to do is go to the

Presentation section. Remember that the transitions are
applied from the current slide to the next.

3

Tutorial 2: Transit authority
QuickTime is a wonderful multimedia standard, which has among other things a selection of visual transitions built in.

These are extremely useful for video projects and now you can also use them to fancy up your PowerPoint presentations.
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for the appearance of each bullet point and
for the moves from slide to slide. To do this,
select Rehearse Timings from the Slide
Show menu and the presentation starts.
Each time you click the mouse, you’ll
trigger the next event and the timing will
be recorded. When you’re happy, you can
save your settings and then later, whenever
you choose one of the automatic display
options, you can be sure that everything
will proceed at exactly the right pace.

The Set Up Show option on the Slide
Show menu enables the slides to be shown
full screen or in a window and you can
choose whether to have it presented by a
speaker, browsed by an individual or
presented on an unattended screen.

The first choice is pretty much self
explanatory – you present it and click
through the slides and bullet points at your
own pace. If you want someone you trust
to be able to browse through it at their

own pace, choose “browsed by an
individual” and the viewer can control the
pace of the presentation. Even if you’ve set
the project to follow your timings, these
can be overridden. The viewer can also
access and change the content via the Edit
Slides option in the Edit menu.

If you want to be able to leave the
presentation running on an unattended
machine, you’ll need “browsed in a kiosk”.
This runs the presentation full screen and
loops it continuously until someone
presses the Escape key.

Whichever way you choose to display
the presentation, it’s best to save it as a
show rather than as a raw PowerPoint file.
In fact, this is essential if you want to use
“browsed in a kiosk”. Use Save As and
choose PowerPoint Show from the popup
menu, so that you can open and display the
show without giving the punters any
access to the main PowerPoint data.

Even more control
If you’ve chosen to run the presentation
yourself and you need to seize control of it
for some reason – perhaps someone asks a
question, which can be answered right
away by reference to a later slide – there’s
now a small, unobtrusive navigation
toolbar at the bottom of the screen. This
means you can leap about the presentation
without the need to quit and look for it or
having to stutter “er, yes, I’ve er, got a slide
about that coming up later, but I er, can’t
get to it right now” which, needless to say,
is terribly unprofessional.

As it almost certainly says in the
publicity somewhere, your presentations
need never be dull again with PowerPoint
2001. Overall, this should be enough to get
you started, but as always we’ve only
scratched the surface and there’s loads
more for you to explore – don’t forget to
make good use of the Assistant. MF

Select Make Movie from the File menu and you’ll
meet this deceptively ordinary-looking file dialogue.
You can either accept the default settings or if you

want more control over the way your movie ends up, click the
Adjust settings radio button before clicking Next.

1 From here you can set the size of your movie and
make a few tweaks to the way it appears in the
QuickTime viewer. One of the more interesting

features is the check box, which asks you if you’d like to
include the original presentation data.

2 If you tick the box, the QuickTime file can be viewed
on any machine with a QuickTime player and it can
be re-opened and edited in PowerPoint. So you don’t

need to save certain versions for certain people. Everyone can
have a QT version whether they’re collaborating or watching.

3

Tutorial 4: Making movies
One thing that’s drastically extended the usefulness of PowerPoint 2001 is its ability to save presentations as QuickTime

movies. Regardless of the platform used, you can exchange presentations without even needing a copy of PowerPoint.

Selecting Save As Web Page from the File menu
brings up a file dialogue with a button marked Web
Options. This takes you to these controls, from which

you can make selections to ensure that the Web version of
your presentation looks exactly as you want it to.

1 There’s just one thing to watch out for with all this
Web wonderfulness – it doesn’t half generate a lot
of files. Our simple four-slide presentation gave rise

to these 54 files as well as the main page itself.

2 But it’s worth it. The result of all those space-filling
files is that your presentation appears in the form of
some very slick Web pages. As with the QuickTime

version you lose the animation, but it does add another
means of sharing your presentations.

3

Tutorial 5: Webbed feat
Just as in all the other components of Office 2001, it’s possible to save PowerPoint presentations as Web pages. And

they’ll look surprisingly impressive, as if you’ve learned some neat new Web design tricks.
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